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Warning!
Before commencing the installation

Disconnect the power supply of the device.

Ensure that devices cannot be accidentally restarted.

Verify isolation from the supply.

Earth and short circuit.

Cover or enclose neighboring units that are live.

Follow the engineering instructions of the device concerned.

Only suitably qualified personnel in accordance with EN 50 110-1/-2 (VDE 0 105 Part 100) may 
work on this device/system.

Before installation and before touching the device ensure that you are free of electrostatic 
charge.

The functional earth (FE) must be connected to the protective earth (PE) or to the potential equal-
ization. The system installer is responsible for implementing this connection.

Connecting cables and signal lines should be installed so that inductive or capacitive interfer-
ence do not impair the automation functions.

Install automation devices and related operating elements in such a way that they are well 
protected against unintentional operation.

Suitable safety hardware and software measures should be implemented for the I/O interface so 
that a line or wire breakage on the signal side does not result in undefined states in the automa-
tion devices.

Ensure a reliable electrical isolation of the low voltage for the 24 volt supply. Only use power 
supply units complying with IEC 60 364-4-41 (VDE 0 100 Part 410) or HD 384.4.41 S2.

Deviations of the mains voltage from the rated value must not exceed the tolerance limits given 
in the specifications, otherwise this may cause malfunction and dangerous operation.

Emergency stop devices complying with IEC/EN 60 204-1 must be effective in all operating 
modes of the automation devices. Unlatching the emergency-stop devices must not cause 
restart.

Devices that are designed for mounting in housings or control cabinets must only be operated 
and controlled after they have been installed with the housing closed. Desktop or portable units 
must only be operated and controlled in enclosed housings.

Measures should be taken to ensure the proper restart of programs interrupted after a voltage 
dip or failure. This should not cause dangerous operating states even for a short time. If neces-
sary, emergency-stop devices should be implemented.

Wherever faults in the automation system may cause damage to persons or property, external 
measures must be implemented to ensure a safe operating state in the event of a fault or 
malfunction (for example, by means of separate limit switches, mechanical interlocks etc.).

The electrical installation must be carried out in accordance with the relevant regulations (e. g. 
with regard to cable cross sections, fuses, PE).

All work relating to transport, installation, commissioning and maintenance must only be carried 
out by qualified personnel. (IEC 60 364 and HD 384 and national work safety regulations).

All shrouds and doors must be kept closed during operation.
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About this manual
1.1 General

In chapter 2, this example describes the programming of TURCK HMIs with CoDeSys V3 (3S-Smart 
Software Solutions GmbH) as well as the visualization with QViS by means of an example using a VT250-
57P with PROFIBUS-DP-Master and a BL67-station for PROIFBUS-DP.

In addition to that, chapter 3 contains a short description of the CoDeSys - TURCK-project templates.

1.1.1 Additional documentation

D301191 "VT250 - Hardware-description"

D301195 "Getting Started - VT250-57P HMI PLC with CANopen"

D301218 "Getting Started - VT250-57x Visualization of Step®-projects"

D301226 "Getting Started - VT250-57x - QViS with Modbus TCP driver"

D301228 "Getting Started - VT250-57x - HMI PLC with Modbus TCP"
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Description of symbols used
1.2 Description of symbols used 

Danger
This sign can be found next to all notes that indicate a source of hazards. This can refer to 
danger to personnel or damage to the system (hardware and software) and to the facility. 

This sign means for the operator: work with extreme caution.

Attention
This sign can be found next to all notes that indicate a potential hazard. 

This can refer to possible danger to personnel and damages to the system (hardware and 
software) and to the facility.

Note
This sign can be found next to all general notes that supply important information about one 
or more operating steps. 

These specific notes are intended to make operation easier and avoid unnecessary work due 
to incorrect operation.
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About this manual
1.3 General 

This manual includes all information necessary for the prescribed use of TURCK HMIs. It has been 
specially conceived for personnel with the necessary qualifications.

1.3.1 Prescribed use

Appropriate transport, storage, deployment and mounting as well as careful operating and thorough 
maintenance guarantee the trouble-free and  safe operation of these devices.

1.3.2 Notes concerning planning/ installation of this product

Attention
Please read this section carefully. Safety aspects cannot be left to chance when dealing with 
electrical equipment.

Danger
The devices described in this manual must be used only in applications prescribed in this 
manual or in the respective technical descriptions, and only with certified components and 
devices from third party manufacturers.

Danger
All respective safety measures and accident protection guidelines must be considered 
carefully and without exception.
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Getting Started
2.1 Used hard-/ software

2.1.1 Hardware

VT250-57x with PROFIBUS-DP master

BL67-GW-DPV1 (DP address 15) 
with:

– BL67-4DI-PD

– BL67-2AI-I with analog sensor Bi5-M18-Li2

– BL67-8DO-0.5A-P

2.1.2 Software

CoDeSys 3.4, SP3, Patch 1

QViS Version 3.1.1.1

Microsoft®.NET Framework 3.5

Note
The VT250-57P only supports the DP-master and not the DP-slave functionality.
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Network configuration and programming in CoDeSys
2.2 Network configuration and programming in CoDeSys

Open CoDeSys via "Start →  All programs →  3S CoDeSys →  CoDeSys →  CoDeSys V 3.4 SP3 Patch1".

2.2.1 Predefined Feature Sets

In this example, CoDeSys is run with the "Professional feature set" not with the "Standard feature set". 
This setting has influence on different CoDeSys functions and can be changed via "Tools → 
Options...→  Features" under "Predefined feature sets...". For further information concerning this topic, 
please read the CoDeSys online help.

Figure 1: 
Predefined fea-
ture sets
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Getting Started
2.2.2 Creating a new project

1 Create a new CoDeSys-project using the "File  →  New project" command. 

2 In the dialog box "New project" which is opened, all installed CoDeSys project templates are shown. 
TURCK offers a special project template for every fieldbus-master (see below Predefined templates/ 
example project (page 2-5)).

Figure 2: 
New project

Figure 3: 
Example 
PROFIBUS-DP 
master
template
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Network configuration and programming in CoDeSys
Predefined templates/ example project

The TURCK CoDeSys-installation contains project templates (incl. already defined master, example 
slave and example program) , which are automatically installed together with CoDeSys. 

They can be opened by using the corresponding template (e. g. TURCK-VT250_DP_M) when creating a 
new project (see chapter 3, Selecting the project templates (page 3-3)).

Creating a new Standard project

3 In the new dialog box "Standard project" the used TURCK VT250-57x (Hans Turck GmbH & Co. KG) is 
selected as "Device".

4 Please define also your preferred programming language. In this example, Structured Text is used. 

5 The new project is created. 

Note
Please read chapter 3, Das CoDeSys-Beispielprojekt (page 3-3) for more detailed information 
concerning the example project.

Figure 4: 
Standard proj-
ect 

Figure 5: 
Selection of the 
VT250-57×
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Getting Started
6 In CoDeSys, the project tree is build up as follows: 

2.2.3 Defining the communication settings 

Double-clicking the "Device Turck VT250-57×" opens the corresponding editors. The communication 
path (Gateway) to the HMI is defined in the "Communication Settings" tab.

Gateway definition

1 Use the "Add gateway"-button to open the dialog box "Gateway" and, where necessary, assign a 
new gateway name.

Figure 6: 
Project tree

Note
If the window "devices" should not be displayed, it can be activated via "View →  Devices".

Note
Please observe, that the VT250-57× and your PC on which CoDeSys is running, are nodes of 
the same Ethernet network! If this is not the case, a communication between the two is not 
possible. If this is not the case, a communication between the two is not possible. 

Please use the TURCK IP Address Tool for assigning the IP address to the VT250. 
Further information can be found in the hardware manual for the VT250 (D301191 "VT250 - 
Hardware-description").
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Network configuration and programming in CoDeSys
2 Keep the setting "localhost" or define an IP-address for the gateway instead
When using the setting "localhost", the CoDeSys-communication-gateway of the PC, on which this 
CoDeSys-installation is running, is used as programming interface.

Figure 7: 
Communica-
tion settings
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Getting Started
Setting the communication path

1 Mark the gateway and scan the network via the respective button. The connected VT250-57-×, in 
this example the VT250-57P-L7-DPM, is found.

2 Mark the VT250-57x and set the active path using the "Set active path" button.

Figure 8: 
Setting the com-
munication 
path
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Network configuration and programming in CoDeSys
2.2.4 Renaming the application

The operating system rcX uses the 8.3-filename convention.

Therefore, it has to be observed, that the name of the stored application file also corresponds to this 
convention.

1 Open the context menu by right-clicking the "Application" and select "Properties".

2 In the "Common"-tab, define an application name with a maximum of 7 characters and confirm it 
with OK. The following warning can be confirmed either. The following warning can be confirmed 
either.

Note
Using an application name, which does not correspond to the 8.3-naming convention, may 
cause data loss and communication problems between PC and VT250-57×!

Figure 9: 
renaming the  
application
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Getting Started
2.2.5 Adding a DP-master

1 Open the context menu by double-clicking the VT250-57x entry. In the dialog "Add Device", select 
the DP master "CIFX-PB" under "Fieldbusses → Profibus → DP Master" and add it to the project tree.

Figure10: 
Add the DP mas-
ter as device
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Network configuration and programming in CoDeSys
2 Double-clicking the DP-master (CIFX_PB) in the VT 250-57P opens the corresponding editors. If 
necessary, set the DP-parameters (Baud rate etc.) according to your application. 

Figure 11: 
Master-
configuration
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Getting Started
2.2.6 Adding DP-slaves

In the project tree, the DP-slaves are added to the DP-master (CIFX_PB). 

1 A right-click on the DP-master opens the context menu. Select "Add Device" and add the DP-slaves 
to the network.

2 If the nodes to be added are not listed in the list of possible DP-devices, first of all the corresponding 
GSD-file has to be added to the CoDeSys "Device Repository".
To do so, please proceed as described in the following.

Adding GSD-files to the CoDeSys Device Repository

1 Open the Device Repository via "Tools  →  Device Repository...".

Figure12: 
Adding DP-
nodes

Note
If CoDeSys is run in Standard mode (see also section "Predefined Feature Sets“, the GSD files 
are installed using "Tools → Install device". 
D301189 - 0811 Getting Started -  VT250 with DP-Master2-12



Network configuration and programming in CoDeSys
2 The Device Repository contains all currently installed devices. Press "Install", select "Profibus DP 
V5.0..." under "File type" and search for the files to be installed.

3 After the installation, the installed devices are listed in the "Device Repository" in the "Installed 
device descriptions"-window under "Fieldbusses →  Profibus  →  DP Slave".

Selection of the BL67-gateway

1 Now, add the BL67-gateway (in this example: BL67-GW-DPV1) to the project by following the 
description above.

Figure13:
Device Reposi-
tory

Figure14: 
Selection of the 
BL67-gateway
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Getting Started
2 Double-clicking on the gateway-entry in the project tree again opens all corresponding editors. In 
the "DP-parameter-tab" →   "identification", set, for example, the nodes DP-address (in this example: 
address 15) or change other parameter settings, if required.

Figure15: 
Example for the 
parameteriza-
tion of the gate-
way
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Network configuration and programming in CoDeSys
Adding BL67 I/O modules

1 Now, right-click the BL67-gateway, open the context menu and select "Add Device" again. 

2 In the "Add Device"-dialog, select the modules connected to the gateway and add them to the 
project. 

In this example:

– Slot 1: BL67-4DI-PD

– Slot 2: BL67-2AI-I, with analog sensor Bi5-M18-Li2

– Slot 3: BL67-8DO-0.5A-P

3 Double-clicking the different I/O module entries again opens the corresponding editors. The 
parameterization of the modules is also done in the "DP Parameter"-tab.

4 The "DP-Module I/O Mapping"-tab shows the I/O-data image for the respective module. 

Figure16: 
Select
I/O modules
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Getting Started
CoDeSys: Global variable list

Global variable are defined in the I/O Mappings of the single I/O-modules:

2.2.7 Programming (example program)

The programming is done under PLC-PRG in the project tree. This example is programmed in ST as 
defined under "Creating a new project".

Small example program

1 The counter counts 

2 The counter value is mirrored to %QB0 (output byte of the BL67-8DO-0.5A-P, "Output counter 
value".

Figure17: 
Example for 
the definition of 
a global 
variable
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Network configuration and programming in CoDeSys
3 The analog value of the sensor at channel 1 ("value_channel1", global variable, &IW1) of the analog 
module at slot 2 in the BL67 station is read out. 

Note
The status of process data is only shown in the process image if a program refers to them.

Figure18: 
Example pro-
gram
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Getting Started
2.2.8 Export of variables

The variables defined in the program have to be exported, for example in order to be used within an 
visualization.

1 Therefore a symbol configuration has to be added to the project. This is done via right-click on 
"APPL" and "Add object". 

2 The symbol configuration shows all available variables (left side of the window) and allows the 
definition of all variables to be exported (right side of the window).

Figure19: 
Add symbol 
configuration
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Network configuration and programming in CoDeSys
3 Mark the variables to be exported and add them to the window "Selected variable" by using the 
arrow keys.
If any variable is missing, please "Refresh" the variable list. 

4 This symbol configuration is automatically stored to the project folder as an *.xml-file during 
Download/ Login of the project. 

5 In case of projects without actually available hardware, it is possible to use the simulation function 
of CoDeSys ("Online → Simulation"). 
Even in simulation mode, an *.xml-file is generated during Login, so that the variables can be 
imported to QViS in order to visualize the project. 

Figure20: 
Select 
variables
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Getting Started
Global variable list

The creation of a "Global Variable List" is possible, too: 
right-click to "APPL  →  Add object  →  Global Variable List".

Define the global variables The global variables are also automatically exported when building the 
project if they ,have been chosen for export in the symbol configuration. (see also Figure20: Select 
variables).

2.2.9 Loading the project into the VT250-57×

1 Building the project:
Building the project is done via "Build →  'Rebuild APL ....".

2 Log-in:
Log-in: The connection to the device is established via "Online →  Login". The application is 
downloaded. The application is downloaded.

3 Create boot application:
Create boot application: A boot project is created via "Online →  Create boot application" and is 
then directly written into the device

4 Starting the program:
Start the program using "Online  →  Start ".

Note
A boot application can only be created in online-mode.
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Network configuration and programming in CoDeSys
5 The program is running (see PLC_PRG in project tree).

Figure21: 
Program run-
ning
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Getting Started
6 CoDeSys 3 also shows that the configuration of the PROFIBUS is correct.

Figure22: 
PROFIBUS-DP 
OK
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Visualization with QViS
2.3 Visualization with QViS

2.3.1 QViS example project

2.3.2 Create a new project

1 Create a new project via "File →  New". In the new dialog box, assign a project name and define the 
storage location of the project.

2 The following settings have to be done:

– Chose "Target Device" for the VT250-57×. The display size is automatically set to 
320×240.

Note
An example project, which explains all important software functions, is installed with the QViS 
installation. It can be found in the software's program directory 
"C:\Programs\Hilscher\`viS_3.1.1.x\Resource\Example1_320x240".

Figure 23: 
New project 

Figure 24: 
Project configu-
ration
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Getting Started
– The visualization-download to the HMI is done via FTP-access. This is also automatically 
set under "Download mechanism".

– Under "Communication driver" select "CoDeSys".

3 A double-click onto the project opens the project file properties. Under "Target" you can find 
amongst others the settings done before 

Figure 25: 
Target Device
settings
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Visualization with QViS
2.3.3 Elements in QViS

Table 1: 
Elements in 
QViS

Function Description

"Insert a variable"
Display of a variable as numeric value or text. The element variable is linked to the 
imported variables from the PLC program.
see Variables (page 2-33)

"Insert a symbol"
– static symbol: figure, e.g. background, logo, etc. which is always shown during runtime
– dynamic symbol: linking of several figures to a variable (e.g. for status indication) 
see Symbols (page 2-30)

"Insert a text"
– static text: text which is always shown during runtime
– dynamic text: several texts can be linked to a variable (e.g. for status indication) 
see Texts (page 2-31)

"Insert a button"
Push-button or switch which can be operated by the user via touch or mouse pointer and 
then triggers a function. 
see Buttons (page 2-35)

"Insert a bargraph"
Display of a bar graph. The bargraph is linked to a variable and changes depending on 
the variable value.
see Bargraph etc. (page 2-34)

""Insert an arc"
Display of an arc. The arc is linked to a variable and changes depending on the variable 
value.

"Insert a pointer instrument"
Display of a pointer instrument. The pointer instrument is linked to a variable and 
changes depending on the variable value. A scale can be added to the pointer 
instrument using the Scale Maker.
see Pointer instrument (page 2-36)

"Insert a vector graphic"
Adding vector graphics (line, circle, etc.).

"Insert a list"
Display of:

– lists with several variable values
– list of alarms or of alarm histories
– lists for creating an input window

"Insert a trend"
Graphic display of the trend of variable values.
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Getting Started
2.3.4 Objects in QViS

Objects are parital masks which consist of one or several elements. 

Compared to elements (variable, symbol, text, etc. see Elements in QViS (page 2-25)), objects have an 
x/y-position and, if linked to variables, can change their position during runtime.

Object are particularly reasonable if element groups have to be used several times on different pages 
of the QViS project. 

Table 2: 
Objects in QViS

Function Description

"Insert an object"
Creating a new object.

"Insert an existing object"
Adding an already made object.
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2.3.5 Variable import

In order to have access from the visualization to the variables of the CoDeSys-project created before, 
the symbol configuration ("project name.Device.Application.name.xml") exported in CoDeSys has to 
be imported.

1 The import is started via "Tools  →Import" 

2 Under "Import file" select the exported-file from CoDeSys (here in the example: 
VT250_Projekt1.Device.APPL.xml). It can be found in the directory of the CoDeSys3 project.

3 Under "Variable list" define the list into which the variables have to be imported (here 
"DefaultVariables.qva").

4 "Read file" reads in the imported variables.

Figure 26: 
Variable
import

Figure 27: 
Variable
import
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5 "Import to Variablelist" starts the import of the marked variables into the defined variable list. 

Figure 28: 
Imported 
Variables in the 
project
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2.3.6 Add pages, rename etc.

Pages are added to the project using the "create new page" button. Via right-click, all pages can be 
renamed, deleted or removed.

In the example:

A new page is added and named "Analog value".

Figure 29: 
New page "Ana-
log value"
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2.3.7 Visualization

The visualization starts on the first page within the project, here in this example on the "Startpage".

Symbols

1 In this example, first of all, a background for the single pages of the visualization is imported. To do 
so, a symbol is placed on the start page.

2 The symbols to be used are added to the project in the "Symbols"-tab within the "Library"-frame 
using the "Add"-button. 

3 If necessary, select user defined symbols and add them to the project.

Note
If needed, change the startpage for your project under "Project properties →   Start page".

Figure 30: 
Add symbols
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4 The symbol is placed on the page using the "Insert a static symbol"-button and is then defined in 
the "Properties"-frame. 
For the example, the background-file is selected here.

Texts

Texts have to be defined in the "Texts"-tab 

1 With "New" a new row is created. The text can then be freely defined for different languages. A 
Double-click onto the respective text makes it possible to edit the entries. 

Figure 31: 
Set background 
as symbol

Figure 32: 
Definition of 
texts
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2 The texts are placed on the page using the "Insert a static text"-button. In the "Properties"-frame, the 
text to be shown is assigned to the text-field (here "Counter Value") and properties such as the 
character set and the position are defined.

Figure 33: 
Definition of 
texts
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Variables

The imported variables are shown in the "Variables"-tab, if the respective variable list is selected (here 
"DefaultVariables.qva", see also section "Variable import"section "Variable import“).

1 The variable is placed on the page using the "Insert a variable"-button. In the "Properties"-frame, the 
variable to be shown is assigned to the variable-field (here "PLC_PRG.Counter") and properties such 
as the character set and the position can be defined. 

Figure 34: 
Definition of  
variables
D301189 - 0811 Getting Started -  VT250 with DP-Master 2-33



Getting Started
Bargraph etc.

1 A bargraph is placed on the page by using the "Insert a bargraph"-button. 
In this example it is used for graphic display of the counter value (variable PRG_PLC.Counter) and is 
therefore also assigned to this variable. 

2 The "Limit minimum" is defined as 0, the "Limit maximum" as 255.

3 Additionally, under the "Properties→ Appearance", the graph’s color (here green) can be defined 
and under "Condition Change Color" it is defined at which value the graph for example changes the 
color. 

Figure 35: 
Insert 
a bargraph
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Buttons

Buttons are placed on the page using the "insert a button"-button. 

Under "Properties", the text, the size, the position etc. can be defined.

Additionally, the button-function (e.g. change page, setting a variable etc.) is defined.

In the example:

1 On the startpage, a button (size 120×40) is created. It will be used to execute a change to the second 
page "Analog value".

– function: "change to page"

– Page: "Analog Value"

2 The button is labeled with the text "Analog Value" (for the procedure of defining texts, please read 
above section "Texts“). 

3 To do so, activate the option "Add text" under "Properties → Appearance" and select the text 
defined before under "Text".

Figure 36: 
Insert a button 
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Pointer instrument

4 On the second page "Analog Value", a pointer instrument is added to display the analog value at 
channel 1 of the analog module in the station. It is linked to the variable "PLC_PRG.analog.value1". 

5 Depending on the application, the pointer value can be customized by changing the options "Min. 
value", "Max. value", "Radius", "Angle from", "Angle to" etc..
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6 Additionally, a scale can be added to the pointer. This is done by using "Start Scale Maker"-function.

7 Here, enter the values for the needed scale, depending on the application.

Figure 37: 
Scale Maker, ex-
ample settings
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8 In addition to that, in this example, a further text "mA" is added. To add the text, please proceed as 
described under Texts (page 2-31).

Figure 38: 
Display of ana-
log value
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"Back"-button

1 In order to go back from the second project page "Analog value" to the start page, an additional 
button is added to the example (please proceed as described under Buttons (page 2-35)).

2 The function "change to previous page" is assigned to the button.

3 In addition to that, a symbol is defined for the button. 

4 To do so, please activate the "Add symbol"-function and select the corresponding symbol under 
"Symbol".

Figure 39: 
Display of ana-
log value
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2.3.8 Compiling the project

Save the project and compile it via the "Build"-button.

Figure 40: 
Compiling the 
project via 
"Build" 
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2.3.9 Simulation of the project

After the compilation, several project functions (change of page etc.) can be tested via the simulation.

Figure 41: 
Simulation 
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2.3.10 Downloading the project

1 The project is now loaded to the VT250-57x via the "Download"-button. 

2 Mark the download via FTP and enter the following settings

– Path on target: ./SYSVOLUME 

– Servername IP-address VT250-57× (here: 192.168.1.25, default: 192.168.1.254)

– Username: netX

– Password: netX

3 Confirm the settings with OK. 

4 The download is started. 

5 Confirm the successful project-download with OK in order to execute a restart at the device.

6 The visualization is now running on the VT250-57×. 

Note
Please make sure that the selected file is the project file.

Figure 42: 
Download
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3.1 General

The CoDeSys version provided by TURCK (to be downloaded from www.turck.de) contains project 
templates for projects with VT250-HMIs. 

The are automatically installed during CoDeSys installation. In addition to that, the installation also 
contains the necessary configuration files (*.gsd, *.eds, etc.) as well a an QViS example project for the 
visualization of the CoDeSys project. 

3.1.1 CoDeSys project templates

These project templates contain, depending on the HMI used:

a preconfigured application (see also Renaming the application (page 2-9)) incl. 

– global variable list (see also Global variable list (page 2-20)), 

– example program (see also Programming (example program) (page 2-16)), 

– symbol configuration (see also Export of variables (page 2-18)) etc.

an example configuration with the correct fieldbus master and possible IOs (see also Adding a DP-
master (page 2-10) and Adding DP-slaves (page 2-12)). 

The project templates can be chosen when creating a new project in CoDeSys. (see alsoSelecting the 
project templates (page 3-3)).

3.1.2 Example visualization in QViS

The QViS example project is also installed during the installation of the TURCK CoDeSys-version.  

It can be found in the software's program directory  "..\3S CoDeSys\CoDeSys\Templates\`viS_3.1.1.x 
demo project".

Note
Please read chapter 2 of this manual or the manufacturer-documentation provided with the 
software-tools CoDeSys and QViS (manuals, online help) in order to learn more about the 
program handling. 

Figure1: 
Directory of he 
demo project
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3.2 The CoDeSys example project

3.2.1 Selecting the project templates

1 Open a new project under "File → New project..." and select the project template depending on the 
fieldbus used.

2 In this example, an HMI with PROFIBUS-DP master is used.

3 Rename the example project if necessary.

Figure2: 
Creating a new 
project with 
template
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3.2.2 Project

3.2.3 Fieldbus master

The example project contains the master to be used depending on the fieldbus. 

Here, in the PROFIBUS-DP project, the PROFIBUS master "CIFX_PB (CIFX-PB)" is added.

Figure3: 
The example 
project

Figure4: 
Example proj-
ect, fieldbus 
master
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3.2.4 Fieldbus slave

The IOs used in the example project consist of a modular DP slave with a BL20-ECO gateway for 
PROFIBUS-DPV1 (BL20-E-GW-DP)  and 2 connected IO-modules, an 8-channel digital input module 
(BL20-E-8DI-24VDC-P) as well as an 8-channel digital output module (BL20-E-8DO-24VDC-0.5A-P).

In the example, PROFIBUS-address 5 is assigned to the gateway. 

3.2.5 Variable declaration in the example project

Global variable list (GVL)

The GVL of the example project contains the following variables:

Figure5: 
Example proj-
ect, slaves

Figure6: 
Example proj-
ect, GVL
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Variable-declaration in the I/O Mapping

In addition to the variable declaration in the GVL, some variables of the example are directly assigned 
at the IO-modules within the BL20 station.

Input module:

bits 0-3 = "xDP_DI_1" to "xDP_DI_4"

Output module:

bits 0-3 = "xDP_DO_1" to "xDP_DO_4"

Figure7: 
Example project 
variable-decla-
ration in "I/O 
Mapping"
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3.2.6 Example program (PLC_PRG) 

Figure8: 
Example pro-
gram 
(PLC_PRG)
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3.3 The  QViS example project

1 Open the example project using "File → Open project...".

2 The project file QViS_3.1.1.x.qpr" can be found in the following directory after the installation of the 
TURCK CoDeSys-version (see also General (page 3-2)). 

Note
Please start QViS first and then open a project. QViS projects cannot be opened via double-
click on the project file. 

Figure9: 
QViS example 
project, 
location
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3.3.1 Variable declaration

Please read chapter 2, Visualization with QViS, Variable import (page 2-27) to learn more about the 
import of program variables to QViS.

1 The variable "Cycle counter" is linked to the global CoDeSys-variable GVL.wCounter". 

Figure10: 
QViS example 
project

Figure11: 
QViS- "Cycle 
counter"
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2 The button "Digital output" is linked to the CoDeSys-variable "GVL.x.Button". Pressing the button 
sets the second output of the digital output module (BL20-E-8DO-24VDC-0.5A-P) in the BL20 
station. 

3 The indicator for the "Digital input" is linked to the CoDeSys-variable "GVL-xLamp" and shows an 
incoming signal at the digital input.

Figure12: 
QViS-
button "Digital 
output"

Figure13: 
QViS-"Digital in-
put"
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4 "PLC RUN state" is linked to the CoDeSys-variable "GVL.xPlcRun" and displays if the PLC-program is 
in RUN state or not. 

Figure14: 
QViS-PLC RUN
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